
 

CES EduPack 2016 

User Manual &  
Getting Started Guide 
 
January 2016 

 



CES EduPack 2016 User Manual and Getting Started Guide 
 

 

© Granta Design 2016 2 

Table of Contents 

1 Introduction ................................................................................................................ 3 

1.1 Where to find help ...................................................................................................... 3 

2 Installation ................................................................................................................. 5 

2.1 System Requirements ................................................................................................. 5 

2.2 License options ............................................................................................................ 5 

2.3 Running the CES EduPack 2016 setup wizard ............................................................. 6 

3 Databases .................................................................................................................. 7 

3.1 Databases for Rational Materials Selection ................................................................ 7 

4 Getting Started with CES EduPack ............................................................................. 9 

4.1 Main tools in CES EduPack .......................................................................................... 9 

4.2 Browsing and Searching ............................................................................................ 10 

4.3 Creating property charts ........................................................................................... 15 

4.4 Filtering and Screening .............................................................................................. 18 

4.5 Putting it all together ................................................................................................ 22 

4.6 Process Selection ....................................................................................................... 23 

4.7 Eco Audit ................................................................................................................... 24 

4.8 Synthesizer Tool ........................................................................................................ 29 

4.9 Saving, Copying, and Report Writing ......................................................................... 30 

5 Toolbars and general information ........................................................................... 32 

5.1 Standard toolbar ....................................................................................................... 32 

5.2 Chart Stage toolbar ................................................................................................... 32 

5.3 CES EduPack file types ............................................................................................... 32 

5.4 Options for Preferred Currency and Units ................................................................ 33 

5.5 Physical Constants and Conversion of Units .............................................................. 34 

6 Legal, acknowledgements, and contact information .............................................. 36 

 



CES EduPack 2016 User Manual and Getting Started Guide 
 

 

© Granta Design 2016 3 

1 Introduction  

CES EduPack supports and enhances the teaching and learning of materials, engineering, design and 
sustainability. It provides a comprehensive database of materials and process information, powerful 
materials software tools, and a range of supporting textbooks, lectures, projects, and exercises. 

CES EduPack is a curriculum-wide resource with specialist Editions for specific disciplines, and three 
levels of the database and software to suit varying needs in all years of undergraduate study and 
postgraduate teaching. It is continually developed based on feedback from the global user community. 

The CES EduPack software provides engaging ways for students to explore and understand the world 
of materials. 

 Become familiar with materials space—with powerful tools to browse and search the 
information in CES EduPack databases. 

 Visualize properties—charting tools help to develop understanding of how material families 
behave. 

 Match materials to applications—for example, by applying a structured approach to 
materials selection; helps students to relate their learning to the world around them. 

 Dig into the underlying science—encourage students to get to grips with the scientific 
principles through textbook-style 'science note' information and textbook links. 

 Evaluate environmental impact with the Eco Audit Tool—explore key eco design concepts; try 
‘what if' scenarios. 

 Additional tools are also available, such as the innovative Synthesizer Tool which allows 
investigation into the benefits of using hybrid materials. 

1.1 Where to find help 

You will be surprised at all the additional help and resources that can be accessed from CES EduPack. 

Getting Started 

 

 
The Installation Guide is the starting point for anyone that has 
not yet installed CES EduPack. 

 

If you have any questions or issues at this stage, you can 
refer to our Student FAQs. 

 

Or the Educator FAQs. 

http://www.grantadesign.com/download/pdf/edupack2016/InstallationGuide_2016.pdf
http://www.grantadesign.com/education/support/FAQs/students.htm
http://www.grantadesign.com/education/support/FAQs/educators.htm
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Learning How CES EduPack Works 

 

 

The User Manual and Getting Started Guide, as well as the 
Video Tutorials, are the best way to learn about the core 
functionality of the software. 

 

 The In-Software Help is accessed from the Help menu, or by 
pressing the F1 key. As well as explaining the core 
functionality, it also includes useful references like the Tables of 
Materials Indices and glossaries of materials terms. 

 

Further Learning 

 

 
The Case Studies were created by Professor Mike Ashby and 
follow the material selection methodology outlined in his book, 
Materials Selection in Mechanical Design. They can be 
completed using CES EduPack. 

 

You can find interactive case studies to practice your skills, 
ready-made Eco Audit project files, and fun databases on 
Granta’s Teaching Resources Website. 

 

The Student Resources page in the software help provides a 
helpful table of resources so you can find information easily. 

 

The online books CES InDepth and CES Concepts explain the 
concepts of selection methodology and the CES EduPack 
databases. 

 

http://www.grantadesign.com/education/resources/videotutorials/2016/index.htm
http://teachingresources.grantadesign.com/case-studies
http://teachingresources.grantadesign.com/
http://www.grantadesign.com/education/InDepth/index.htm
http://www.grantadesign.com/education/Concepts/index.htm
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2 Installation 

This part of the User Manual provides instructions for registering and installing your copy of the CES 
EduPack system. 

2.1 System Requirements 

To install CES EduPack 2016 you will need:  

 A compatible Microsoft® Windows® operating system;  

o Windows Vista 32-bit or 64-bit SP2, 
o Windows 7 32-bit or 64-bit,  
o Windows 8 32-bit or 64-bit,  
o Windows 10 32-bit or 64-bit. 

 4 GB of RAM. 

 4 GB of available hard disk space. 

 Microsoft .NET Framework Client version 4.0 and ReportViewer 2010 SP1. For the French 
language installation you will also require the French language packs for both of these. If 
these are not already installed on your PC, you will be given the option to add them 
automatically to the CES EduPack installation process. 

 Administrator rights. 

 Internet access, if you wish to use the web-based search, the online resources, or connect to 
datasheets from external databases, where applicable. 

2.2 License options 

Students 

If you are a student installing this on your own computer, then you should have been given a license 
key and access to the files to install CES EduPack 2016. Please ask your instructor for a license key if you 
do not have one. 

For the Student FAQ page, please go to: 
www.grantadesign.com/education/support/FAQs/students.htm 

Educators 

Enrollment licenses are licenses for a group of students for a limited period of time. You and your 
students will need the license key on the Software License Agreement to install CES EduPack 2016. 

Lab licenses are perpetual licenses for a fixed number of computers. You or your IT department will 
need the license key on the Software License Agreement to install CES EduPack 2016. 

For the Educators FAQ page, please go to: 
www.grantadesign.com/education/support/FAQs/educators.htm 

Network Administrators 

Please follow this link for information on installing the software over a network: 
www.grantadesign.com/education/network. 

www.grantadesign.com/education/support/FAQs/students.htm
http://www.grantadesign.com/education/support/FAQs/educators.htm
http://www.grantadesign.com/education/network
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For the Network Administration FAQ page please go to: 
www.grantadesign.com/education/support/FAQs/network.htm. 

2.3 Running the CES EduPack 2016 setup wizard 

If you have installed a previous version or evaluation copy of CES EduPack, we recommend that you 
uninstall it before installing this version. To do so, use Programs and Features in Windows Control 
Panel to uninstall the software. 

To install CES EduPack 2016, copy the files onto your computer. Run setup.exe and follow the 
instructions in the setup wizard. You can click Cancel to quit the installation at any point.  

You can find a video of the installation process at: 
www.grantadesign.com/education/resources/videotutorials/2016/index.htm. 

http://www.grantadesign.com/education/support/FAQs/network.htm
http://www.grantadesign.com/education/resources/videotutorials/2016/index.htm
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3 Databases 

Different databases are available depending on your installation. 

The databases are split into Introductory – Level 1 and 2 databases – and Advanced – Level 3 databases 
– with different editions to cover specific areas of study e.g. Aerospace and Sustainability. 

There are video Database Tours, to give you more information on the different levels and databases: 
www.grantadesign.com/education/resources/videotutorials/2016/index.htm. 

3.1 Databases for Rational Materials Selection 

The MaterialUniverse and ProcessUniverse data tables are used with CES EduPack to create high 
quality databases that you won't find elsewhere. They are designed for like-to-like comparisons 
across the whole spectrum of material and processing possibilities. Typical material databases do not 
allow this - the most common reasons being: 'holes in the data'; and different properties reported for 
different materials. This makes it difficult to compare different classes of materials.  

Universe data tables solve the problem by conforming to strict database design principles. These 
principles are reviewed below, with reference to the MaterialUniverse data table. 

Complete spectrum represented 

The MaterialUniverse data table contains a representation of virtually every commercial engineering 
material in every class. This means that you can be sure that you have considered all material 
possibilities for any particular application. 

Each material represented only once 

Multiple instances of the same material from different producers are consolidated into one 
representative record. This reduces the complexity of the engineer's search for the best material. 

Property ranges 

Properties of real materials are seldom exact - there are inevitable variations from batch to batch 
and manufacturer to manufacturer. These variations are captured in a Universe data table by a 
range. The range may be small for a property such as density, but relatively large for price or 
toughness. 

Complete property set 

In a Universe data table, there is a value for every property on the datasheet. If a value is not known 
experimentally, it has been estimated using intelligent estimating techniques. These estimates are 
based on well-established correlations between material properties, using fundamental physics. 

Quality checks 

Granta has examined hundreds of material datasets over the years from various sources and, 
without exception, they contain errors - sometimes by as much as 1000%! To minimize errors in the 
Universe data tables, strict data checking procedures are used. These include checks that properties 
for specific material classes fall within acceptable ranges, and powerful science-based checks on the 
correlations between properties. 

http://www.grantadesign.com/education/resources/videotutorials/2016/index.htm
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Normalization 

All properties are presented in the same unit system, which can be chosen by the user. Properties 
that are reported in different ways for different materials classes are equivalenced to enable 
comparison. 

Hierarchy 

The carefully-constructed record hierarchy allows simple and rapid navigation to all records in the 
data table. 

References 

The reference source is given at the bottom of the datasheet, to encourage students to question and 
research where the data comes from. 

The Result 

Applying these principles required a great amount of work in data collection and processing. The 
MaterialUniverse data table represents over 50 man-years of effort spread over a 20 year period. The 
rewards of this effort are immediate and numerous with the MaterialUniverse and ProcessUniverse 
databases used in combination with the CES EduPack software. 
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4 Getting Started with CES EduPack 

The exercises in this section give an overview of CES EduPack and will teach you how to use the core 
functionality. There is a comprehensive help file within the software that provides further guidance, 
as well as containing case studies and tutorials. 

4.1 Main tools in CES EduPack 

The main tools in CES EduPack are: 

  
BROWSE Explore the database and retrieve records via a hierarchical index or 

tree. 

SEARCH Find information via a full-text search of records. 

SELECT The central hub of CES EduPack, used to apply the Rational Material 
Selection methodology. A powerful selection engine that identifies 
records that meet an array of design criteria and enables trade-offs 
between competing objectives.  

CHART Create charts and add formatting and labels to illustrate your point. 

ECO AUDIT Quickly estimate the environmental impact of a product over its 
entire lifecycle and study What If design scenarios. The enhanced 
version also accounts for Secondary, Joining, and Finishing processes, 
and allows you to apply the same What If scenarios to the economic 
cost.  

SYNTHESIZER 
TOOL 

Predict performance of materials by modelling new hybrid materials, 
or modelling part cost of a design; compare these results with 
existing records. 

The following exercises cover the use and functionality of these tools.  
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4.2 Browsing and Searching 

Exercise 1 — Opening a Database 

On starting CES EduPack, the Databases window will appear, showing all installed databases. The 
following exercises use the MaterialUniverse and ProcessUniverse tables which are found within all 
Granta material databases. After clicking on a database name in the Databases window to select it, 
the Homepage then opens to show a list of the available tables and a graphic for each subset.  

 

 

 

Click a subset name to show its description. Use the information icon next to the database name to 
view a detailed description. There are also links to online resources, for both students and educators, 
from the home page. 

 Select Edu Level 2 database 

Note:  Unless otherwise stated, all exercises and screenshots in this guide were 
produced using Edu Level 2 database. Results and images may differ if you complete 
these exercises using a different database.  

 Select different subsets and read about the available data and applications 

Click a subset in the Homepage to select it. The information displayed is for the currently-
selected subset.  

 Change to the PROCESSUNIVERSE table 

Click ProcessUniverse and notice that the Browse tree in the left panel updates. 

  Close the HOME PAGE 

Click the cross at the top of the Home page tab. This page can be reopened at any time by 
clicking Home on the main toolbar.  
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  Change to the MATERIALUNIVERSE table 

With the Homepage closed, navigate to different tables using the Table list in the Browse 
window.  

Search SelectBrowse

Table:

Subset:

MaterialUniverse

Edu Level 2

 

Exercise 2 — Browse Material Records 

 Select the Table MaterialUniverse and the Subset Edu Level 2. 

Search SelectBrowse

Table:

Subset:

MaterialUniverse

Edu Level 2

MaterialUniverse

Ceramics and glasses

Hybrids: composites, foams...

Metals and alloys

Polymers and elastomers

 

 Find the record for STAINLESS STEEL 

Double-click on a folder in the browse tree to view the records and folders below it. Find the 
record for CONCRETE 

 Open the GENERIC record for POLYPROPYLENE (Level 3 Databases only) 

Generic records are records at the folder level. They provide general information on the 
material, rather than data on a specific variant. They have their own icon:  .  

 Open a POLYPROPYLENE record 

Double-click the record name in the tree to view the datasheet. 

Click hyperlinked attribute names. In Level 1 and Level 2 databases, this will bring up a Science 
Note, giving details of the underlying science and calculations for the attribute. In Level 3 
databases, this will bring up the design note, which provides background information on 
properties, test notes, and selection guidelines. From a design note, there will also be a link to 
the corresponding Science Note. 

Right-click the datasheet to see a context menu with further actions, for example, locate in 
Browse tree, copy the datasheet, print the datasheet, and export the data to an FE package 
format. 
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 Find PROCESSES that can shape POLYPROPYLENE using the ProcessUniverse Link at the 
bottom of the datasheet. 

Part of the Polypropylene Level 2 datasheet: 

  

For more information on the property and to drill down to the underlying science, click  to view the 
science note. 
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Exercise 3 — Browse Process Records 

 Browse ProcessUniverse: Edu Level 2 All Processes 

ProcessUniverse

Search SelectBrowse

Table:

Subset:

ProcessUniverse

Edu Level 2 All Processes

Surface treatment

Shaping

Joining

 

 Find the record for INJECTION MOLDING, THERMOPLASTICS 

 
 Find the record for VAPOR METALLIZING (PVD) 

 
 Find the record for FRICTION WELDING (METALS) 

 
 Find materials that can be DIE CAST, using the link to the MaterialUniverse at the bottom of 

the datasheet for DIE CASTING 
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Exercise 4 — Searching 

 Find the material POLYLACTIDE 

Browse SelectSearch

Polylactide

 

 Find the materials used as CUTTING TOOLS 

 
 Find the process VACUUM ASSISTED RTM 

The folder name is also included in the search. If the term appears in a folder name, all 
records under that folder will be returned; for example, a search for ceramics would return 
all records in the folder named Ceramics and glasses. 

 Enter the search term ALUM* 

Records containing the term Alumina or Aluminum or Alumino are returned.  

Advanced searches 

The following search operators are available: 

AND Finds records containing both the search terms, so steel AND alloy 
returns only records containing both the words steel and alloy 

OR Finds records containing either search term, so steel OR alloy returns all 
records that contain steel, alloy, or both 

NOT Finds records containing the first search term, but not the second, so 
steel NOT alloy returns only records with the word steel but without the 
word alloy 

Phrase Search Finds the exact search term, so “steel alloy” will return only records 
containing the exact phrase steel alloy 

Parentheses  Used to group search terms, so iron AND (ore OR cast) will return the 
records containing iron and containing either ore, cast, or both 

Wildcards  Use ? as a wildcard single character, or * as a wildcard representing any 
number of characters (cannot be used as the first character in a search 
string) 

Note:  AND operators are automatically added when a search has two or more terms 
and no other operators have been entered.  

Exercise 5 — Find Supporting Information 

You will need an internet connection for this exercise. 

CES EduPack translates the material ID to search strings compatible with a group of high-quality 
material and process information sources, and delivers the search results. Many of the sources 
require a subscriber-based password. The ASM source is particularly recommended. 
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 Search the web to find more information on PET 

With the PET datasheet open, click Tools > Search Web.  

4.3 Creating property charts 

Bar charts and bubble charts are a great way to visualize and communicate material properties, as 
well as being a key tool to support systematic materials selection. 

Exercise 6 — Create a bar chart 

 Select MATERIALUNIVERSE: EDU LEVEL 2 

Click Chart/Select, and then select MaterialUniverse: Edu Level 2 subset. 

 Make a bar chart of YOUNG’S MODULUS (E) 

Under Selection Stages, click Chart. 

Set the y-axis attribute to Young's modulus, then click OK. 

For a bar chart, you do not set an x-axis: leave x-axis set to <None>. 

2. Selection Stages

Chart TreeLimit

SearchBrowse Select

1. Selection Data

Select from: MaterialUniverse: Edu Level 2

Young’s modulusAttribute:

Y-axis

Chart Stage

 

 Explore the chart 

Click Zoom in  and then drag to zoom in on an area of the chart. 

Click Zoom out   to zoom out. 

Click Autoscale  to zoom back to view the whole chart again. 

 Label records on the chart 

Click a record in the chart and then drag to add and position a new data label.  

To delete a data label, select it and press DELETE. To delete all labels in the chart, press 
CTRL+A and then press DELETE. 
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Exercise 7 — Create a bubble chart 

 Make a bubble chart plotting YOUNG'S MODULUS (E) against DENSITY (ρ) 

Under Selection Stages, click Chart. 

Set the y-axis to Young’s modulus and set the x-axis to Density.  

Leave the Axis Settings as default values to create a log-log plot.  

2. Selection Stages

Chart TreeLimit

SearchBrowse Select

1. Selection Data

Select from: MaterialUniverse: Edu Level 2

Chart Stage

Young’s modulusAttribute:

Y-axis

DensityAttribute:

X-axis

 

 Display family envelopes 

Click  to look at how data for a given family of materials cluster together. 

 Label records on the chart 

Zoom in and label some records (click over a record and drag). 



CES EduPack 2016 User Manual and Getting Started Guide 
 

 

© Granta Design 2016 17 

Try adding labels from the Results list: select a record  in the list, right-click and select Label 
on the shortcut menu, then then drag the label where you want it on the chart. 

If the new label isn’t visible at the current zoom, click Autoscale  to display the whole 
chart again. 

 

 Delete this stage 

Select the stage in the Selection Stages list and press DELETE. 
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4.4 Filtering and Screening 

Exercise 8 — Selection Using a Chart Stage 

When plotted on a Chart Stage, records can also be filtered using the Index line and Box selection 
tools. This provides a more qualitative approach to filtering.  

2. Selection Stages

Chart TreeLimit

SearchBrowse Select

Density

Y
ie

ld
 s

tr
e

n
g

th Index line

Y
ie

ld
 s

tr
e

n
g

th

Box 

selection

Bar chart1

Bubble chart2

3. Results X out of Y pass

Material 1

Material 2

Material 3

Material 4

etc.

1. Selection Data

Select from: MaterialUniverse: Edu Level 2

 

 Make a Bar Chart of YIELD STRENGTH (σy) 

Set the y-axis to Yield strength (elastic limit). 

 Use a Box selection to identify materials with high values of YIELD STRENGTH 

Click Box selection  , then drag to define the selection box. 
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 Add DENSITY (ρ) to the x-axis 

Click Chart Settings  then click the X-Axis tab and select Density as the axis attribute.  

 Use an INDEX LINE to identify materials with high values of the specific strength σy / ρ 

Click Index and display lines . 

The objective of the line is set to Maximize the index by default, which will result in selection 
of materials above the line, for high values of σy / ρ.  

Click OK and then click the chart to position the line through a particular point.  

Drag the line upwards to refine the selection to fewer materials. 

 

 Add a Box selection to the chart to identify materials with low DENSITY that maximize the 
index.    

 

 Rank the results by specific strength (YIELD STRENGTH / DENSITY) 

Show: Stage 1: Yield strength v. Density 

Rank by: Stage 1: Index value. 

Example results: Softwood, Bambo, Paper. 

 Delete this stage 

Select the stage in the Selection Stages list and press DELETE. 
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Exercise 9 — Selection Using a Limit Stage 

SearchBrowse Select

1. Selection Data

Select from: MaterialUniverse: Edu Level 2

3. Results X out of Y pass

Material 1

Material 2

Material 3

Material 4

etc.

Max. service temp.

Thermal conductivity

°C200

25 W/m.°C

Min Max

Limit Stage

Impact & fracture properties

Thermal properties

Electrical  properties

Electrical resistivity μohm.cm1e15

Min Max

Limit 

guidance

2. Selection Stages

Chart TreeLimit

 

 Select materials with specific thermal and electrical properties. 

Create a new Limit Stage with the following criteria: 

MAX. SERVICE TEMPERATURE > 200 °C 

THERMAL CONDUCTIVITY > 25 W/m.°C 

ELECTRICAL RESISTIVITY > 1e15 μohm.cm 

Example results: Aluminum nitride, Alumina, Silicon nitride. 

Use the limit bars for guidance on suitable values. Enter the limits – minimum or maximum 
as appropriate – and click Apply.  

You can change the units on the datasheet by clicking the Units tab under Tools > Settings. 

 Filter the results further to select only materials with non-opaque TRANSPARENCY. 

Under Optical Properties, in the Transparency list, select Translucent, Transparent, and 
Optical quality.  

Click Apply.  

Example results: Alumina and Silicon Nitride. 

 Delete this stage.  
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Selection Using a Tree Stage 

Using a Tree Selection Stage, you can filter records based on their links to records in other data 
tables, or based on the database hierarchy (tree). 

SearchBrowse Select

1. Selection Data

Select from: MaterialUniverse: Edu Level 2

Tree stage for material

Ceramics

Hybrids

Metals

Polymers

Steels

Al alloys

Cu alloys

Ni alloys...

Material

3. Results X out of Y pass

Material 1

Material 2

Material 3

Material 4

etc.

2. Selection Stages

Chart TreeLimit

 

 Find materials that can be MOLDED 

Under Selection Stages, click  Tree. In the Tree Stage window, select ProcessUniverse, 
navigate to Molding, and click Insert, then click OK. 

 Click Show to see a list of the materials in MaterialUniverse to which this process is linked. 

 
 Delete this stage. 

 
 Find processes to join STEELS 

In the Selection Project pane, under Selection Data, select ProcessUniverse: Joining.  

Under Selection Stages, click  Tree. Select MaterialUniverse, expand Metals and alloys, 
select Ferrous, and then click Insert followed by OK. 

 Delete this stage. 
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4.5 Putting it all together 

Exercise 10 — Combining Filtering and Charting Tools 

SearchBrowse Select

1. Selection Data

Select from: MaterialUniverse: Edu Level 2
Limit stage

Density

Yield strength

T-conductivity

2000

60

10

Min Max

1

P
ri
c
e

Chart stage3

Cast

Deform

Mold

Composite

Powder

Prototype

Surface

Process

Join

Shape

Tree stage2

3. Results X out of Y pass; ranked by PRICE

Material 1

Material 2

Material 3

Material 4

etc.

2. Selection Stages

Chart TreeLimit

 

 Choose the data source. 

Select from: MaterialUniverse: Edu Level 2. 

 Select materials with specific physical, mechanical, and thermal properties. 

Add a Limit Stage with the following criteria: 

DENSITY < 2000 kg/m^3 

YIELD STRENGTH (Elastic limit) > 60 MPa 

THERMAL CONDUCTIVITY < 10 W/m.°C 

 Filter the results to find those that can be THERMOFORMED 

Add a Tree Stage and select ProcessUniverse > Shaping > Molding > Thermoplastic molding > 
Thermoforming. 

 Rank the results by PRICE and find the three cheapest materials 

Add a Chart Stage with a bar chart of Price. On the Chart Stage, all materials that fail one or 
more stages are grayed out. The Results window by default lists the materials that pass all 
stages. 

In the Rank by list, select Stage 3: Price. 
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4.6 Process Selection 

Exercise 11 — Selecting Processes 

 

 Choose the data source  

Select from: ProcessUniverse: Edu Level 2 Shaping. 

 Find PRIMARY SHAPING PROCESSES to make a component with specific shape, physical, and 
economic properties. 

Add a Limit Stage with five criteria: 

SHAPE Dished sheet 

MASS 10 - 12 kg 

SECTION THICKNESS 4 mm 

PROCESS CHARACTERISTICS Primary shaping process 

ECONOMIC BATCH SIZE > 1000 

 Filter the results to only include THERMOPLASTIC materials 

Add a Tree Stage and select MaterialUniverse - Polymers and Elastomers - Polymers - 
Thermoplastics. 

Example results: Rotational molding, Compression molding, Thermoforming. 

  

2. Selection Stages

Chart TreeLimit

Ceramics

Hybrids

Metals

Polymers
Polymers

Material
Thermoplastics

SearchBrowse Select

1. Selection Data

Select from: ProcessUniverse: Edu Level 2 Shaping Limit stage1

Mass range

Range of section thickness

kg10 12

4 4 mm

1000Economic batch size (units)

Primary shaping processes 

Shape

Dished sheet 

Physical attributes

Process characteristics

Economic attributes

Tree stage2

Elastomers

Thermosets

1 2
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4.7 Eco Audit 

The Eco Audit Tool is not available in the Bio-Engineering Edition of CES EduPack. 

The Eco Audit Tool estimates the energy used and CO2 produced during five key life 
phases of a product (material, manufacture, transport, use, and end of life), and 
identifies which phase has the dominant contribution. This is the starting point for 

eco-aware product design, as it identifies which parameters need to be targeted to reduce the eco-
footprint of the product. 

A brand of bottled mineral water is sold in 1 liter PET bottles with polypropylene caps. A bottle 
weighs 40 grams; the cap 1 gram. Bottles and caps are molded, filled, and transported 550 km from 
the French Alps to England by 14 tonne truck, refrigerated for 2 days and then sold. The overall life of 
the bottle is one year. 

An example product file for this case study is installed with CES EduPack in the Samples folder, with 
the filename Bottle PET - Level 2.prd. 

Product Definition 

The following example shows how the example product file has been created.  

For an explanation of the calculations used at each stage, click Help  in the heading.  
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1. Material, manufacture, and end of life 

Bill of materials (BoM) and primary processing method. 

Qty

Component 

name Material

Recycled 

content

Primary 

process

Mass 

(kg) End of life

Virgin (0%)
Polymer extrusion

Recycle

Landfill

Combust

Downcycle

Re-manufacture

Reuse

Polymer moldiVirgin (0%) 0.04PET ...Bottle100

None

Polymer molding

MaterialUniverse

PET

Polymer moldiVirgin (0%) 0.001PP (homogCap100

1Dead weight100

Recycle

Combust

None

Thermoplastics

Ceramics and glasses

Electrical components

Hybrids: composites, ...

Metals and alloys

Polymers: plastics, elas

 

2. Transport 

Transportation from site of manufacture to point of sale. 

Sea freight

Rail freight

14 tonne truck

...

Air freight – long haul

Stage Name Transport type Distance (km)

Bottling plant to point of sale 14 tonne truck 550

14 tonne truck

 

3. Use 

Product Life and Location Use 

France

Germany

United Kingdom

...

Product life: years

Country of use:

1

United Kingdom

United Kingdom
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Static Mode 

Energy used to refrigerate product at point of sale (average energy required to refrigerate 100 
bottles at 4°C = 0.12kW). 

Product uses the following energy:

Energy input and output:

Power rating:

Usage:

Usage:

days per year

hours per day

Electric to mechanical (electric motors)

0.12

2

24

kW
Fossil fuel to thermal, enclosed system

Fossil fuel to electric

Electric to thermal

...

Electric to mechanical (electric motors)

 

4. Report 

Summary chart enables rapid identification of the dominant life phase. Toggle between views of 
energy usage or CO2 footprint.  

 

The chart shows that, in this project, Material is the dominant life phase. Each life phase can be 
clicked to show guidance on strategies to reduce its impact.  

Detailed report provides a component-by-component breakdown of each life phase, enabling the 
main contributors to the dominant life phase to be identified.  

Exercise 12 — Compare Eco Audit Projects 

 Open the Bottle PET - Level 2 product file. 

Click Open and locate the sample product file Bottle PET - Level 2.prd, located in the Samples 
folder in your CES EduPack installation folder. For example: 
C:\Program files (x86)\CES EduPack 2016\Samples\eco_audit\en\Bottle PET - Level 2.prd 

 Create a copy of this product for comparison 

Click Compare with and select Copy of current product. 
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Eco Audit Project

New Open Save Compare with      

Product definition

Copy of current product

New product

Saved product ...

Compare with      

 

 Set the following values in for the new product: 

NAME PET Bottle (Recycled) 

RECYCLED CONTENT 35% 

 Generate the SUMMARY CHART 

 

The first life energy (not including EoL potential) is reduced by 15%.  

Note:  The chart can be copied into a document or printed using Copy and Print at the 
top of the chart window.  

Exercise 13 — Saving and Exporting 

Eco Audit projects do not form part of a selection project and therefore need to be saved separately.  

 SAVE the product definition 

Eco Audit Project

New Open Save Compare with      

Product definition Report
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 GENERATE the Eco Audit report 

Click the Report tab (or click Detailed Report on the Product definition tab). 

 EXPORT the report as a PDF 

You will require a PDF reader such as Adobe Reader to view the exported report. 

Product definition

Excel

PDF

Word

Eco Audit Project

New Open Save Compare with      

Report

 

Note:  The Level 3 Eco Design and Level 3 Sustainability databases contain an enhanced 
version of the Eco Audit tool, containing options to include a secondary process and cost 
analysis in the audit. Please read the in-software help, or the online teaching resources 
for information on how to get started with these advanced features. 
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4.8 Synthesizer Tool 

The Synthesizer Tool is only available in some advanced editions of CES EduPack.  

The Synthesizer Tool is designed for use in the early stage of product 
development. It consists of two types of models: hybrid models, for estimating the 
performance of novel materials and structures; and the part cost estimator, for 

calculating the cost of a component based on the material and process chain. 

Synthesized records produced using the Synthesizer Tool can then be compared with existing records 
in the MaterialUniverse database using selection stages. 

Exercise 14 — Hybrid Model: Sandwich Panels Model  

Hybrid materials and structures combine the benefits of two or more materials to produce new 
materials that exhibit unique combinations of properties. For example, both composite materials and 
sandwich panels are commonly used to create strong, lightweight structures.  

Note:  You will need a Level 3 database for this exercise. 

 Make a BUBBLE CHART of YOUNG’S MODULUS (E) against DENSITY (ρ) using 
MaterialUniverse: All bulk materials 

As in Exercise 7. 

 Use the SANDWICH PANELS MODEL to create synthesized records for a family of hybrid 
materials 

Click Synthesizer on the toolbar (or click Tools > Synthesizer on the menu bar).  

Select the Sandwich Panels – Balanced model.  

 

 Set the SOURCE RECORD values 

FACE-SHEET Aluminum, 6061, wrought, T6 

CORE Polymethacrylimide foam (rigid, 0.200) 

Click Browse and locate the records in the tree. 

 Leave the default values for MODEL VARIABLES and MODEL PARAMETERS, and set the 
following  RECORD NAMING values: 

FACE-SHEET Al 

CORE Rohacell 

 CREATE the synthesized records 

Click Create and then Finish. The new synthesized records will be shown in the Results list 
and on the Chart Stage. 

Note:  Click the help icon in the Synthesizer Tool dialog to view further information 
about the current model type, including details of the calculations used.  

 Plot an INDEX LINE corresponding to a lightweight, stiff panel in bending E1/3/ρ 

Click Index and display lines, enter a slope of 3, and maximize the index. 
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 Add labels to the source records and some of the synthesized records  

You can select individual records on the chart and drag to place a label. 

You can also add labels from the Results list: select one or more records in the Results list, 
right-click and select Label on the shortcut menu, then then drag the labels where you want 
them on the chart. 

Click  Highlight synthesized records to help you identify the synthesized records on the 
chart.  

Use the Zoom controls  and  to zoom in to the area of interest on the chart. 

 

Synthesized records appear on the Browse tree under My Records and may be edited or deleted in a 
similar way to User Defined records.  

MaterialUniverse

...

My records

Synthesized

...

20mm core

Add Record

Edit Record

Delete Record

0.05mm Al face-sheet

0.0834mm Al face-sheet

 

4.9 Saving, Copying, and Report Writing 

Exercise 15 — Adding Comments and Saving a Project 

You can add comments to a selection project as a reminder of why you have applied certain 
constraints and objectives. Comments are displayed on mouse-over in the selection report, and are 
saved in the project file. 

Comments can be added to all selection stages in a project.  
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2. Selection Stages

Chart TreeLimit

Stage

Limit

Stage Properties

Title

Notes

Limit

Stage

 

 Click Notes   in the stage window heading, then enter some comments 

 

 Save the project 

On the File menu, click Save Project. Give the project a filename and directory location; the 
project will be saved with the file extension .ces.  

Exercise 16 — Exporting and Copying 

Charts, records, and results lists can be copied and pasted into a document in another application 
such as Microsoft® Word, Microsoft Excel, Microsoft Powerpoint, or Notepad.  

 Copy a chart into a document 

To copy a chart to the clipboard: in the chart window, right-click the chart and select Copy on 
the shortcut menu, or press CTRL+C.  

You can then paste the chart image from the clipboard into your document.  

 Copy a datasheet into a document 

To copy a datasheet to the clipboard: open the datasheet, then right-click the datasheet, and 
select Copy on the shortcut menu, or press CTRL+C. 

You can then paste the data from the clipboard into your document.  

 Copy results into a document 

To copy results to the clipboard, use SHIFT+click or CTRL+click to highlight the records you 
want, then right-click and select Copy on the shortcut menu, or press CTRL+C. 

To select all results in the list, right-click and select Select All on the shortcut menu, or press 
CTRL+A. 

You can then paste the results from the clipboard into your document.  

 Try editing the document you have created 
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5 Toolbars and general information 

5.1 Standard toolbar 

 

 

 

 

 

5.2 Chart Stage toolbar 

 

 

 

 

 

 

 

 

 

5.3 CES EduPack file types 

*.gdb  Granta Database file 

*.ces  CES Project file 

*.cet  Selection Template file 

*.frl  Favorites file 

*.prd  Eco Audit Product Definition file 
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5.4 Options for Preferred Currency and Units 

Settings 

Database options 

Preferred Currency Preferred Unit System 

<Automatic> The Regional Setting from the 
operating system for currency is 
used to view data.  

This will appear as: 
  <Automatic - Regional Currency> 

For example: 
  <Automatic - GBP>. 

The Regional setting from the 
operating system for unit system is 
used to view data.  

This will appear as: 
   <Automatic - Regional Units>  

For example: 
   <Automatic - Metric>. 

<None> Data is displayed using the same 
currency as it is stored with in the 
database. 

Numeric data is displayed using the 
same units as the data is stored 
with in the database. 

Named setting Named currency is used to 

display data. 

Named unit system is used to 

display data. 
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5.5 Physical Constants and Conversion of Units 

Physical Constants 
 

Absolute zero temperature -273.2°C 

Acceleration due to gravity, g 9.807 m/s2
 

Avogadro’s number NA 6.022 x 1023
 

Base of natural logarithm, e 2.718 

Boltzmann’s constant, kB 1.381 x 10-23 J/K 

Faraday’s constant, F 9.648 x 104 C/mol 

Gas constant, R 8.314 J/mol/K 

Plank’s constant, h 6.626 x 10-34 Js 

Speed of light in a vacuum, c 2.998 x 108 m/s 

Volume of perfect gas at STP 22.41 x 10-3 m3/mol 

Conversion of units 
 

Angle,  1 rad 57.30° 

Density,  1 lb/ft3 16.03 kg/m3
 

Diffusion coefficient, D 1 cm2/s 1.0 x 10-4 m2/s 

Energy, U See below 

Force, F 
1 kgf 
1 lbf 
1 dyne 

9.807 N 
4.448 N 

1.0 x 10-5 N 

Length, l 

1 ft 
1 inch 
1 Å 

304.8 mm 
25.40 mm 
0.1 nm 

Mass, M 

1 tonne 
1 short ton 
1 long ton 
1 lb mass 

1000 kg 
908 kg 
1107 kg 
0.454 kg 

Power, P See below 

Stress,  See below 

Specific Heat, Cp 
1 cal/gal.°C 
1 Btu/lb.°F 

4.188 kJ/kg.°C 
4.187 kJ/kg.°C 

Stress Intensity, K1c 1 ksi in 1.10 MN/m3/2
 

Surface Energy,  1 erg/cm2
 1 mJ/m2

 

Temperature, T 1°F 0.556K 

Thermal Conductivity, 
1 cal/s.cm.°C 
1 Btu/h.ft.°F 

418.8 W/m.°C 

1.731 W/m.°C 

Volume, V 
1 Imperial gall 
1 US gall 

1.546 x 10-3 m3
 

3.785 x 10-3 m3
 

Viscosity, 
1 poise 
1 lb ft.s 

0.1 N.s/m2 

0.1517 N.s/m2
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Conversion of Units - Stress and Pressure 
 

 MPa dyn/cm2
 lb/in2

 kgf/mm2
 bar long ton/in2

 

MPa 1 107
 1.45 x 102

 0.102 10 6.48 x 10-2
 

dyn/cm2
 10-7 1 1.45 x 10-5

 1.02 x 10-8
 10-6 6.48 x 10-9

 

lb/in2
 6.89 x 10-3

 6.89 x 104
 1 703 x 10-4

 6.89 x 10-2
 4.46 x 10-4

 

kgf/mm2
 9.81 9.81 x 107

 1.42 x 103
 1 98.1 63.5 x 10-2

 

bar 0.10 106
 14.48 1.02 x 10-2

 1 6.48 x 10-3
 

long ton/in2
 15.44 1.54 x 108

 2.24 x 103
 1.54 1.54 x 102

 1 

Conversion of Units - Energy 

 

 J erg cal eV Btu ft lbf 

J 1 107
 0.239 6.24 x 1018

 9.48 x 10-4
 0.738 

erg 10-7 1 2.39 x 10-8
 6.24 x 1011

 9.48 x 10-11
 7.38 x 10-8

 

cal 4.19 4.19 x 107
 1 2.61 x 1019

 3.97 x 10-3
 3.09 

eV 1.60 x 10-19
 1.60 x 10-12

 3.38 x 10-20
 1 1.52 x 10-22

 1.18 x 10-19
 

Btu 1.06 x 103
 1.06 x 1010

 2.52 x 102
 6.59 x 1021

 1 7.78 x 102
 

ft lbf 1.36 1.36 x 107
 0.324 8.46 x 1018

 1.29 x 10-3
 1 

Conversion of Units – Power 

 

 kW (kJ/s) erg/s hp ft lbf/s 

kW (kJ/s) 1 10-10 1.34 7.38 x 102
 

erg/s 10-10 1 1.34 x 10-10
 7.38 x 10-8

 

hp 7.46 x 10-1
 7.46 x 109

 1 15.50 x 102
 

ft lbf/s 1.36 x 10-3
 1.36 x 107

 1.82 x 10-3
 1 
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6 Legal, acknowledgements, and contact information 

Legal and Acknowledgments 

License Agreement 

CES EduPack is furnished under a License Agreement and may be used or copied only in accordance 
with the terms of the License. 

Trademarks 

Cambridge Engineering Selector, CES Constructor, CES EduPack, CES INDEPTH, CES LAB, CES Selector, 
CES WEB, Eco Audit, Eco Materials Adviser, Granta Design, Granta Material Intelligence, Granta 
Material Inspiration, GRANTA MI, Hybrid Synthesizer, Synthesizer Tool, MaterialUniverse, 
ProcessUniverse, the GRANTA, GRANTA Material Intelligence, and GRANTA Material Inspiration 
logos, the Granta CES EduPack and Granta CES Selector logos are trademarks of Granta Design Ltd. 

Microsoft®, Excel®, PowerPoint®, Internet Explorer®, SQL Server®, Windows®, and Windows Server® 
are registered trademarks of Microsoft Corporation or its subsidiaries in the United States or other 
countries. 

Granta Design Ltd. makes reasonable efforts to explicitly acknowledge all trademarks cited in our 
literature or on our website. If you would like us to add or alter an acknowledgement, please contact 
us. 

Reproduction 

Except as described in the installation instructions, neither the documentation nor the software may 
be copied, reproduced, translated, or reduced to any electronic medium or machine readable form, in 
whole or part, without prior written consent of Granta Design Limited. 

Teaching Materials 

Selection charts, record data, and online teaching resources may be reproduced to be used with 
students for educational purposes only, as long as Granta Design Limited are referenced as the source 
and copyright owner or licensor. 

To reproduce these in published works you must: 

i. gain prior written permission from Granta Design Limited (contact details to be found at 
www.grantadesign.com/contact). 

ii. acknowledge each instance with the following: 

bibliographical reference: 

Charts/data/etc. from “CES EduPack 2016, Granta Design Limited, UK 
(www.grantadesign.com)”. 

Images - please see the individual image caption for reproduction information of images. 

  

http://www.grantadesign.com/contact
http://www.grantadesign.com/contact
http://www.grantadesign.com/contact
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Contact details 

If you have any questions, you can contact us at info@grantadesign.com or at one of the phone 
numbers below. 

International Headquarters:  Tel: +44 (1)1223 518895 
Fax: +44 (0)1223 506432 

USA Headquarters Toll-free: 1-800-241-1546 
Fax: 1-216-274-9812 

France Appellez-nous au numéro vert: 08 00 76 12 90 
Fax: 01 53 01 69 66 

Germany Tel: 089 921 315 230 
Granta für Lehre: 0800 182 5026 
Fax: 08005 89431 5000 

For further details, see the contact details page of the Granta Design website, 
www.grantadesign.com. 
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